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1. Vigtigt

Denne elektroniske brugervejledning er beregnet
til alle, der bruger Philips-skaermen. Tag den tid du
behgver for at lase vejledningen, inden du bruger
skaeermen. Den indeholder vigtige oplysninger om

bemarkninger angaende brugen af din skeerm.

Philips garanti deekker under forudsatning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formal i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og vedligeholdelse

) Advarsler

Anvendelse af kontrolelementer; justeringer eller
fremgangsmader; der ikke er beskrevet i denne
dokumentation, kan resultere i elektrisk stad,
elektriske ulykker og/eller mekaniske ulykker.
Laes og felg disse vejledninger, ndr du tilslutter og
anvender din computerskaerm:

Betjening

»  Skeermen skal holdes veek fra direkte sollys,
savel som meget kraftigt lys og andre
varmekilder. Leengere udsettelse for disse
typer omgivelser kan medfare affarvning og
beskadige skaermen.

* Fjern alt, der kan risikere at falde i
ventilationshullerne eller forhindre korrekt
afkgling af skeermens elektronik.

* Bloker ikke ventilationshullerne pa kabinettet.

* Ved placering af skeermen skal du sikre dig,
at det er let at komme til stremstikket og
stikkontakten.

*  Hvis der slukkes for skeermen ved at fierne
stremkablet eller jeevnstremsledningen, skal du
vente 6 sekunder; for du setter stremkablet
eller jevnstremsledningen til igen for at opna
normal betjening.

*  Brug altid et godkendt stremkabel, der
er leveret af Philips. Hvis du mangler dit
strgmkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

o Udsat ikke skaermen for kraftige vibrationer
eller stad under anvendelse.

*  Sla ikke pa skeermen, og tab den ikke under
brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du undga
at trykke kraftigt pa skaermpanelet. Nar du
flytter din skaerm, sa tag fat om rammen for at
lzfte den; laft ikke skeermen ved at satte din
hand eller fingre pa skeermpanelet.

* Tag stikket ud fra skeermen, hvis du ikke skal
bruge den i en leengere periode.

* Tag stikket ud at kontakten til skeermen, hvis
du skal renggre den med en let fugtet klud.
Skaermen kan tgrres af med en tar klud,
nar der er slukket for stremmen. Under alle
omsteendigheder, ma der ikke bruges organiske
oplgsningsmidler til renggring af din skaerm.

* For at undga risiko for elektrisk stad eller
permant beskadigelse af anleegget, sa ma du
ikke udseette skeermen for stev, regn, vand eller
miljiger med hgj fugtighed.

*  Huvis din skaem bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

*  Hvis der kommer fremmed substans eller vand
ind i skeermen, sa sluk straks for stremmen og
tag stikker ud. Fjern derefter den fremmede
substans eller vandet, og send skaermen til
servicecenteret.

*  Skaermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* For at opretholde den bedste ydelse af din
skeerm og for langvarig brug, sa brug skeermen
et sted, der er indenfor felgende temperatur-
og fugtighedsomrade.

o Temperatur: 0-40°C 32-95°F
o Fugtighed: 20-80% RH



Vlgtlge oplysninger om burn in/skyggebillede
Serg altid for at aktivere en pauseskarm,
der beveeger sig, nar skeermen efterlades
uden at blive anvendt. Du skal altid bruge
en pauseskarm eller et andet program, der
opdaterer skeermen regelmaessigt, hvis du
viser statisk materiale i leengere perioder.
Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage, at det
“breendes fast” pa skaermen, dvs. de sakaldte
“spogelsesbilleder” pa din skaerm.

* Fastbreending” og "spegelsesbilleder”
er velkendte fenomener inden for
skeermpanel-teknologien. “Fastbrending” og
“'spagelsesbilleder” forsvinder oftest gradvist
efter en vis periode, efter skaermen er slukket.

) Advarsel

Huvis du ikke aktiverer pauseskermen eller
regelmeessigt opdaterer skeermbilledet kan det
medfere symptomer pa "burn-in", “after-image”
eller “skyggebillede”, der ikke forsvinder og ikke
kan repareres. Ovennaevnte skader er ikke daekket
af garantien.

Service

* Kabinettet ma kun &bnes af kvalificeret
servicepersonale.

* Huvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter: (Se kapitel om
"Kundeinformationscenter")

* For oplysninger om transport, se "Tekniske
specifikationer”.

+ Efterlad ikke din skaerm i en bil/bagagerum
under direkte sollys.

© Bemarkning

Kontakt en servicetekniker; hvis skeermen ikke
fungerer korrekt, eller hvis du er usikker pa, hvad
du skal gare, nar betjeningsinstruktionerne, der er
givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Folgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forsigtighedsregler og advarsler

| hele denne vejledning kan tekstblokke vaere
ledsaget af et ikon og std med fed eller kursiv
skrift. Disse blokke indeholder bemaerkninger og
punkter; hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som fglger:

© Bemarkning

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan ggre bedre brug af
computersystemet.

@O Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab af
data.

) Advarsel

Dette ikon angiver risiko for personskader og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater og
er eventuelt ikke ledsaget af et ikon. | sadanne
tilfelde er den givne udformning af advarslen
lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og emballage

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of,

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please

visit wwwi.philips.com/about/sustainability/recycling.



2. Sat basen ind i VESA monteringsomradet.
2. Opsatning af skaerm

2.1 Installation

El Emballagens indhold

B
Start

PHILIPS

3. Hold pa skaermens stander med begge
hander, og st med en fast hand standeren
ind i fodsgjlen.

(1) Paszt forsigtigt fodstykket pa fodsgjlen,
saledes at lasen fastlaser fodstykket.

(2) Speend skruen, der sidder nederst pa
fodstykket med fingrene, sa fodstykket
sidder godt fast pa fodsgjlen.

DVI (optional) VGA (optional)
Bl Installation af stander
1. Anbring skeermen med forsiden vendt nedad

pa en blgd og jeevn overflade, og var forsigtig
med ikke at ridse eller beskadige skaermen.




E Tilslutning til PC

PHILIPS

@ Kensington anti-tyverisikring
© VGA-indgang

© DVI-D input

© Display port (241B4LPY)
O Lydindgang

O AC stremindgang

@ Nulstremkontakt

© USB downstream

© USB upstream

Tilslutning til pc

1.

Tilslut ledningen ordentligt pa bagsiden af
skeermen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pa computeren.

Forbind pc-lydkablet til lydstikket bag pa
computeren.

Seet computerens og skaermens
netledninger til et stik i naerheden.
Forbind USB skeermens upstream-port
og pc'ens USB port med et USB kabel.
Downstream-porten er nu klar til enhver
USB tilslutning.

Teend for computeren og skaermen. Hvis
skarmen viser et billede, er installationen
gennemfort.

2.2 Brug af skaerm

/<

10 /Y SENSOR /A /0K 0)

| | I |
(4] e o

El Produktbeskrivelse set forfra

@ (O |Forattende og slukke for skeermen.

© | ©/0K |S&dan far du adgang til OSD-menuen.

© | AV [Sidanjusteresi OSD.

O | 55 |PowerSensor:

© | 1 |Tilindstilling af skaermens lydstyrke.

0 < ga; S lii\g,zaz I' det forrige
Smartlmage. Der kan vaelges mellem
seks indstillinger: Office (Kontor),

@ | () Photo (Bilede), Movie (Film), Game

(Spil), Economy (@konomi) og Off
(Slukket).




F1 Beskrivelse af OSD-skarmen

Hvad er OSD (On-Screen Display)?

Visning pa skeermen [On-Screen Display

(OSD)] er en funktion pa alle Philips skeerme.
Den satter en slutbruger i stand til at justere
skaermindstillingerne, eller vaelge skaermens
funktioner direkte via et instruktionsvindue pa
skaermen. Et brugervenligt skaermvisningsinterface
vises som nedenfor:

Grundlzggende og enkle anvisninger til
kontrolknapperne

Pa OSD-skaermen, der er vist ovenfor, kan brugere
bruge v a-knapperne pa skaermens frontkant til at
bevage cursoren med, OK for at bekrafte et valg
eller en eendring.

OSD-menuen

Nedenstaende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende den
som opslag, nar du senere skal orientere dig i de
forskellige justeringer.

Mainmenu  Submenu
— 01,234
— PowerSensor E On
off
— Inpuc — VGA

DVI (available for selective models)

M1

DisplayPort (available for selective models)

Picture Format — Wide screen, 4:3, 16:9, 1:1

[— Picture Brightness ~ — 0~100

Contrast — 0~100

SmartContrast — On, Off

Gamma — 18,20,22,24,26

Stand-Alone  — On, Off
— Audio

Mute — On, Off

DP Audio ~ — DP, Audio In (available for selective models)

Color Temp. —— 5000K, 6500K, 7500K, 8200K, 9300K, 11500K
— Color

SRGB

User Define Red: 0~100

E Green: 0~100
Blue: 0~100

— Language — English,Espafiol, Frangais, Deutsch, ltaliano,

Portugués, Pycckuit, FAeL

— Horizontal ~ — 0~100
[— OSD Settings
f— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time out — 5, 10,20, 30, 60
— Auto
— Power LED — 01234
— H. Position — 0~100
L Setwp
[— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
[— Resolution Notification —  On, Off
[ Reset — Yes,No
L— Information




2. Opsatning af skaerm

El Meddelelse om oplgsning Hejdejustering

Denne skaerm er designet til optimal ydelse ved
dens naturlige oplasning: 1920%1080 ved 60Hz.
Nar skeermen bruger en anden oplgsning, ses
felgende advarsel pa skeermen: Brug 1920x1080
ved 60Hz for at opnd det bedste resultat.
Advarslen vedrgrende den naturlige oplgsning
kan deaktiveres under Setup (Installation) i OSD
(skeermmenuen).

B Fysisk funktion

Vip

Drej




2.3 Fjern standeren og foden Bl Fiernelse af foden

El Fjernelse af foden Betingelse:

Inden du begynder at adskille skeermens stander, *  For standard montering af VESA
skal du felge vejledningerne nedenfor for at undga

beskadigelse og personskade. 1. Udtreek standeren til dens maksimale hgjde.

1. Anbring skeermen med forsiden vendt nedad pa
en jeevn overflade, og veer forsigtig med ikke at
ridse eller beskadige skeermen.

2. Anbring skeermen med forsiden vendt nedad
pa en jeevn overflade, og veer forsigtig med ikke
at ridse eller beskadige skeermen. Laft derefter

2. Aftag fodstykket fra fodsgjlen ved at: skaermens stander:

(1) Lasne skruen, der sidder nederst pd
fodstykket, med fingrene.

(2) Skub forsigtigt op og ned for at udlase
lasen, der laser fodstykket, og treek
fodstykket af fodsgjlen.

3. Udlgs standerens las og treek standeren vaek fra
fodsgijlen.




© Bemarkning
Denne skarm accepterer et 100mm x 100mm
VESA-kompliant monteringsinterface.

PHILIPS

100mm

100mm




3. Optimering af billede

3.1 Smart-billede

El Hvad er dette?

Smart-billede er forvalgte indstillinger; der
optimerer skeermen i henhold til indholdet, og
som realtid dynamisk indstiller lysstyrke, kontrast,
farve og skarphed. Uanset om du arbejder

med tekstprogrammer, ser billeder eller ser
video, sa giver Philips Smartimage den optimale
skeermydelse.

El Hvorfor behgver jeg det?

Du gnsker en skaerm, som giver det bedste billede

for alle typer indhold. For at @ge skerm-oplevelsen,
indstiller Smartlmage-softwaret dynamisk lysstyrke,

kontrast, farve og skarphed i realtid.
El Hvordan virker det?

Smart-billede er en eksklusiv, farende Philips-
teknologi, som analyserer indholdet pa skeermen.
Ud fra det valgte scenarie forbedrer Smartlmage
dynamisk billeders og videoers kontrast,
farvemathed og skarphed for at forbedre det
viste billede — alt i realtid og blot med et tryk pa
en knap.

1 Hvordan aktiveres Smart-billede?

1. Tryk p& B] for at starte Smart-billede pa
skaermen;

2. Fortset med at trykke pa B for at skifte
mellem Office (Kontor), Photo (Foto), Movie
(Film), Game (Spil), Economy (@konomi) og
Off (Fra).

3. Smart-billede ses pa skaermen i fem sekunder,
men du kan ogsa trykke pa OK for at
bekraefte.

4. Nar Smart-billede er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge sRGB
skal du deaktivere Smart-billede med @) foran
pa skaermen.

Udover at bruge B til at rulle ned med, kan du
ogsa trykke pa v A for at vaelge og derefter trykke
pa OK for at bekreefte valget og derefter igen
lukke Smart-billede OSD.



Der kan veelges mellem seks tilstande: Office
(Kontor), Photo (Foto), Movie (Film), Game (Spil),
Economy (Dkonomi) og Off (Fra).

@ Smartimage

Dffice

Photos

Game

Economy

Off

Office (Kontor): Forbedrer teksten og
daemper lysstyrken for at gge lasbarheden

og nedsatte anstrengelsen af gjnene. Denne
tilstand @ger afgarende leesbarheden og
produktiviteten, ndr der arbejdes med
regneark, PDF filer, skannede artikler og andre
generelle kontorprogrammer.

Photo (Foto): Denne profil kombinerer
farvemathed og dynamisk kontrast og skarphed
for at vise billeder og lignende overordentlig
klart og i levende farver — alt uden synlige fejl i
det indskannede billede og blegnede farver.
Movie (Film): Viser hver detalje i videoernes
mearkere omrader med gget luminans,

dyb farvemaethed, dynamisk kontrast

og barberbladsagtig skarphed og uden
farveudvaskning i de lysere omrader og opnar
pa denne made dynamiske, naturlige vaerdier
med henblik pa den ultimative videovisning.
Game (Spil): Aktivér overdrive-kredslgbet for
at fa den bedste reaktionstid, reducere skeeve
kanter for genstande, der bevager sig hurtigt
pa skeermen, forbedre kontrastforholdet for
lys og marke. Denne profil giver spillere den
bedste oplevelse af spil.

Economy (@konomi): Med denne profil
indstilles lysstyrke og kontrast, ligesom
baggrundslys fintunes for at opna det rette
billede til hverdagens kontorprogrammer.
Nedsat strgmforbrug.

Off (Fra): Ingen optimering med Smart-billede.

I

3.2 Smart-kontrast

El Hvad er dette?

Unik teknologi, der dynamisk analyserer det viste
indhold og automatisk optimerer en skarms
kontrastforhold til maksimal visuel klarhed.

Den gger baggrundsbelysningen og giver et
klarere, friskere og lysere billede eller deemper
baggrundsbelysningen med henblik pa en tydelig
visning af billeder pa merk baggrund.

El Hvorfor behgver jeg det?

Du gnsker den allerbedste visuelle klarhed

og visning ved enhver type indhold. Smart-
kontrast styrer dynamisk kontrast og indstiller
baggrundslyset, sa det giver klare, friske og lyse
spil- og videobilleder og viser tydelig, leesbar tekst
ved kontorarbejde.Ved at nedsatte skaermens
stremforbrug, sparer du energiomkostninger og
forleenger skaermens levetid.

E Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid for at indstille farver

og baggrundslysets intensitet. Denne funktion
forbedrer dynamisk kontrasten og giver saledes en
bedre underholdningsoplevelse, nar du ser videoer
eller spiller spil.



3.3 Smart-farvemathed

El Hvad er dette?

Smart-teknologien, der styrer farvemathed — dvs.
graden, med hvilken én skeermfave sammenblandes
med nabofarverne — giver rige og livlige billeder
sa du kan opleve bedre underholdning, nar du ser
videoer.

E1 Hvorfor behover jeg det?

Du gnsker rige og livlige billeder for mere
underholdning og sjov, nar du ser billeder og
videoer.

El Hvordan virker det?

SmartSaturate kontrollerer dynamisk farvemaethed,
graden som skaermens farver sammenblandes
med nabofarverne, for at kunne gengive rige,
livlige billeder for bedre underholdning nar du

ser billeder eller videoer i skeermtilstanden Movie
(Film) eller Game (Spil). Funktionen er deaktiveret
for visning af kontorprogrammer i topkvalitet, samt
i tilstanden Economy (@konomi) for at reducere
stremforbruget.
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3.4 Smart-skarphed

El Hvad er dette?

Smart-teknologien, som @ger skarpheden, nar du
behgver den til ultimativ billedydelse og mere
underholdning og sjov, nar du ser videoer og
billeder.

E1 Hvorfor behgver jeg det?

Du gnsker den ultimative skarphed for mere
underholdning og sjov, nar du ser billeder og
videoer.

El Hvordan virker det?

Smart-teknologien @ger skarpheden, nar du
behgver den, til ultimativ billedydelse og mere
underholdning og sjov, nar du ser videoer og
billeder i tilstanden Movie (Film) eller Game
(Spil). Funktionen er deaktiveret for visning

af kontorprogrammer i topkvalitet, samt i
tilstanden Economy (@konomi) for at reducere
stremforbruget.



3.5 Philips SmartControl Premium Guide for forste start
* Efter installation af SmartControl Premium

Det nye SmartControl Premium-software fra abnes guiden automatisk, nar du abner

Phillips giver dig mulighed for at kontrollere programmet ferste gang.

skaermen via et nemt, grafisk interface. *  Guiden leder dig trin for trin gennem indstilling
Komplicerede justeringer hgrer fortiden til. af skeermen.

Dette brugervenlige software guider dig gennem *  Du kan ogsé ga til Plug-in menuen for at starte
finindstilling af opl@sning, kalibrering af farve, guiden pd et senere tidspunkt.

justeringer af clockning/fase, RGB-hvidpunkt osv. * | Standard-ruden kan du indstille flere
funktioner uden guide.

Udstyret med den seneste teknologi i algoritmer

for hurtig behandling og reaktion, er denne

igjnefaldende, ikon-baserede software, der ogsa er

Windows 7 parat, klar til at forbedre din oplevelse

med Philips-skeermel!

[&] smartControl Premium 2%

SmartControl Premium PHILIPS

Wizard

You'l need to calbrats

tuning process
“This process nvolves a seres of stey

]

Adiust Preferences

2. Folow the steps outined i th process.
3. Save your settings for future use.

El Installation

* Folg instruktionen og fuldfer installationen.

* Du kan starte, nar installationen er fuldfert.

*  Hvis du vil begynde senere, kan du klikke
pa genvejen pa skrivebordet eller pa
varktgjslinjen.

i

W

Theft Deterrence

Multi Montors

TEL

Help Start Waard

PHILIPS www philips.com/welcome

Recuird seps Monitor driver and software installation
> S L Syem reqicements:

- PC runoing Windows 7. Vi, XP, 2000, 98

Philps SmareControl
Syom swpport snd requrement:

1. Sytam support Windows 7. Vs X.
s, French,olan, Russan, P hed Chnsse

2P

> Quksoap Que

sofvare

13



F1 Start med Standard-rude

(€] soariConeot Premiom

SmartControl Premivm

Adjust menu (Indstillingsmenu):

Med "Adjust” ("Indstilling”-)menuen kan

du indstille Brightness (Lysstyrke), Contrast
(Kontrast), Focus (Fokus), Position (Position)
og Resolution (Oplgsning).

Foretag indstillingen ved at felge @

Brightness

po— b

instruktionerne.

Installationen kan annulleres med Cancel i py

(Annuller). R Py
... A

€] snartConvo Premiom

SmartContro| Premium

Color
\g oo
Eco
. pateon
3 Reton

SmartControl Premium

“ Brghtness

Color w

, Contrast
\g Foaus
Eco
- Postion
Xs Resokition
Options
Hebp

@y Options

PHILIPS \g
Brightness oo >

Improperly adjusted Brightness wil result 1 a loss of
deta n darker image areas. Adjust the Brightness for
the best possble picture qualty.

1. Lower the Brightness to the mnimum level.

2. Raise the Brightness to the desred level.

3. Adjust the Brightness as needed to achieve

(& Sraront v
R g o

SmartControl Premium

Bightness 100 i
o oW
undo Reset D
Brghtness
Color
. Contrast
\g Foaus
Eco
- s
Xs Resoluton
% Optons
Contrast fres
Adjust the Contrast (use the sider) to keep detais <

lghter mage areas.
1. Rae the Contrast unti the numbers 1 and 2
are o longer visble.
2. Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visble

(] soariConeo rmim

SmartControl Premium

Contrast

Undo Reset \
. Brightness

Contrast

A

Focus

Postion

Soltion

14

PHILIPS

Focus

Your dsplay’s timing needs to be synchronized with
the video sgnal
1. Choose Auto Setup.
I the vertical bands are stil visble, you'l need
to adjust the Pitch.

Pitch: Try to make the vertical bands dsappear.
Phase: Adjust to the brightest setting to mnmze
movement on the screer

pich 50
= o &
Phase 9%
o O—w
Undu Auto Semu

20X

PHILIPS

Position

Use the Position buttons to center the image on
your dsplay. Using this tool, you can postion the image
up, down, left, or right.

Use the Up/Down buttons to center the image

verticaly.
Use the Left/Right buttons to center the image
horizontaly.

Undo Reset

PHILIPS

Resolution

You are currently 3t 3 Preferred resolution. For your

dsplay to show crsp, clear text, colors, and images,

Your dispiay should be set to s Preferred resolution.

I your display s at a Non-Preferred resolution, cick

on the Preferred button to change your resokution to
red.

T~ Enable Resolution Notfier

Picture Format
I 433pectratio




Farvemenu:
Med "“Color” (“Farve”-)menuen kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration
(Farvekalibrering) og Smart-Billede

(se afsnittet Smart-Billede).

Foretag indstillingen ved at felge

instruktionerne.

Se nedenstaende oversigt med
undermenupunkter baseret pa dit input.
Eksempel pa Color Calibration

(Farvekalibrering).
(] smarCortrol Premiem

SmartControl Premium

o
Adjust
U B
Color Biack Level
X! ke ot
Eco Display Gamma
= !
Calibration
@“‘7
Options Smartimage
Heb

(& SmartControt premiom

SmartControl Premium

Back Level
‘White Pont

&
Adjust
!‘ W
RG8
Eco Display Gamma
!
X? clbrton
@‘—w

Optons Smartimage

&

PHILIPS

RGB

All dsplayed colors are produced by mixing Red, Blue,
and Green at different brightness levek. Choosng 3
neutral White Pont wil give you optimal RG. If you
prefer to adjust the RGB now, folow these steps:

1. Adjust the intensty of the Red, Green, and

Blue using the sider bars.

NOTE: Changing the RGB values can adversely effect
the displayed colors.

Red 100
= oW
Green 100
= oW
Ble 100
g O

undo Reset

2%

PHILIPS

White Point

White Point s the pont at which equal combrations
of red, green, and blue it at ful intensty create
white. Thi effects the overal color quaity. For the
most accurate colors cick the Reset button then
select the White Pont.
1. Please select the White Pont value for the best
possble color qualty.

White Pont 6500K
o © &

undo Reset

€] snaront oo

SmartControl Premium

Adjust
U &
Color Back Level
Ze Display Gamma.
= )
Galbration
@p
Options. Smartmage

®

Ve
PHILIPS

Display Gamma

(Gamma & a component of the psel brghtness n 3
display. A lower Gamma value produces brighter pixels
and 2 igher Gamma vabe produces darker poxes, The
defauk value for Gamma is 2.2.

To adjust Gamma, Smartimage must be set to Off.
Clck the Smartlmage Off button before adjusting
ma.

1. Usa the sider to select the desred Gamm.

Display Gamma
=] o}

&R

Smartimage OFf

undo Reset.

W sraront Pomion

SmartControl Premium

Adiust
»
= 2.
Xg vt pont
e Diplay Ga:lvma
El‘—v
Options. ‘Smartimage
e
Help
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Calibration

Your disply needs to be propery calibrated n order
for t to produce the widest range of colrs accurately.
Calibration should ahways take place as the kst tuning
step i the process. Remember to recalbrate any time
you make indidual adjustments to image qualey or
whenever you move your dsplay to 2 new location.

.+ Make al other necessary adiustments to image
qualey frst.

. Press Show Me to leam how to use the
calibration tools.

. Finaly, press Start to beg the calibration
process.

¥ Enable color calbration
Color software designed i colaboration with Joseph

Holmes.
Protected by LLS. Patent No. 6,686,953

Show Me start

Quick Vew

“Show Me” (“Vis Mig") starter vejledningen i

farvekalibrering.

““Start” — starter 6-trins farvekalibrerings-

sekvensen.

“Quick View" (“Quick-visning") indlaeser for/

efter-billederne.

For at vende tilbage til “Color” (“Farve”-)
startruden, skal du klikke pa “Cancel”

(“Annuller”).

Aktiver farvekalibrering — der som standard
er aktiveret. Hvis markeringen er fiernet, kan
der ikke ske farvekalibrering, ligesom start- og
quick-visning knapperne er gratonede.

Der skal veere patent-oplysninger pa

kalibreringsskaermen.



Forst farvekalibreringsskaerm:

*  “Previous” (“Foregdende’-) knap er
deaktiveret, indtil den anden farveskarm.

* “Next” (“Naste”) gér til efterfalgende mal
(seks mal).

*  “Final next” (“Afsluttende Neeste) gar til File >
Presets (File > Forvalg) rude.

»  “Cancel” (“Annuller”) lukker Ul og vender
tilbage til “plug in"-) siden.

Smart-billede:

Smart-Billede — tillader brugeren at @ndre
indstillingen for at opna en bedre skaermindstilling
baseret pa indhold.

Nar der indstilles pa “Entertainment”
(“Underholdning”), aktiveres Smart-Kontrast og
Smart-Svar

(] smartControl Premium @

SmartControl Premium PHILIPS

Smartimage
e ‘SmartImage provides different brightness and
contrast levels to accomodate today's wide range of
computer applications.
Ad Choose the setting that is most comfortable or
L2 efficient when viewing your application. Atemativel,
o ‘smply choose the one that best descrbes s type.
@ o
= 2.
Q wateran:
B0 Display Gamma
w ) a
Galbration i
Options artimage = &
g Photo Movie
Help Economy Game.
C )
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(] Serarscarisi reveam

SmartControl Premium

&

Adiust

—
Color

Power Savings
Eco
Optons
Help

<

Schedule Power Savings

PHILIPS

Schedule Power Savings

When powered on, the diplay is using power, even
the screen s black. Adjust the settings on this pane to
minmize the power usage during mactiy.

P Tmes————
Idle Timer - Use the Idke sider to set the standby.
Imode timer. After the screen goes dark, any mouse
for keyboard actiiy restores the deskcop.

Off Timer - After the display enters standby
mode, the Power Off Timer begins to count down.
\Use the Power Off sider to adjust the length of time
\before the display is automatically tumed off. Note
Once the display off, the power button must be
lressed to tum the dispiay back on.

- ¥ Schedule Daiy Power Off ———————
|Select the time and day for the display to Power Off
automaticaly.
[7:00] T Monday I™ Tuesday ™ Wednesday
™ Thursday I~ Friday
I saturday ™ Sunday

Idle never
=0 &
Power oOff 0 miute
=0 &
Standby Now Tum Power Off Now

Theft Deterence (Anti-tyveri)-ruden er kun aktiv,
nar tilstanden Theft Deterence (Anti-tyveri) er
valgt i Plug Ins-rullemenuen.

emcairo

SmartControl Premium

Preferences
Audio
Auto Pivot
Input
e
Presets
Theft Deterrence.

SmartDesktop

TERY

Vi)
PHILIPS

Theft Deterrence

Theft Deterrence protects your display against
unauthorzed removal rom your computer. To Enable
“Theft Deterrence, cick on On. Frst-tme users wil
requre 3 Personal Identfication Number (PIN). If the
disply is removed from this computer, this PIN s
needed to authorze use on another computer.

[
Theft Deterrence Off

on



For at aktivere Theft Deterence (Anti-tyveri), skal

du klikke pa tilstanden Enable Theft Deterrence

(Aktiver Anti-tyveri), hvorefter fglgende skaerm ses:

* Der kan kun indtastes en PIN-kode pa fra fire
til ni cifre.

* Nar PIN-koden er indtastet, leder “Accept”
("Accept’-) knappen brugeren til pop-op
dialogboksen pa falgende side.

*  Minimum-minutter er fem. Skyderen star som
standard pa 5.

e Kraever ikke, at skeermen forbindes til en anden
veert for at ga i tilstanden Theft Deterrence
(Anti-tyveri).

[ 7x

SmartControl Premium PHILIPS

Theft Deterrence

T

i

Adjust

i

Color

@

. SUNTET O P

‘E L

Optons

E
)
7

L)

g

&

Help on

Nar der er oprettet en PIN-kode, indikerer “Theft
Deterrence” ruden, at “Theft Deterrence” er
aktiveret og giver PIN-kode funktionsknap:

* “Theft Deterrence Enabled” ("“Anti-tyver
Aktiveret”) ses.

* Tilstanden Disable Theft Deterrence
(Deaktiver Anti-tyveri) dbner rudeskermen pa
naeste side.

* PIN-kode Funktioner knappen virker kun, nar
brugeren har oprettet PIN-kode. Knappen
abner sikkert PIN-kode websted.
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“Options > Preferences” (“Funktioner >
Indstillinger”) — er kun aktiv, nar Preferences
(Indstillinger) er valgt i “Options” (*‘Funktioner’-)
rullemenuen-rullemenuen. Pa en ikke-understattet
skeerm med DDC/Ci er kun “Help” (“Hjaelp”) og
“Options” (“Funktioner™) til radighed.

] smartControl Premium 2

SmartControl Premium PHILIPS

Preferences

* Viser nuveerende, foretrukne indstillinger.

*  Funktionen aktiveres ved at afmarke feltet.
Afmeerkningsfeltet er en flip-flop.

*  “Enable Task Tray” (“‘Aktiver Jobbakke")
menuen er som standard afmeerket (Til)
pa skrivebordet. Menuen Enable Context
(Aktivér kontekst) viser valgmulighederne i
SmartControl Premium for Select Preset
(Veelg Forvalg) ogTune Display (Indstil Display)
i genvejmenuen ved hgjreklik pa skrivebordet.
Disabled (Deaktiveret) fierner SmartControl
Premium fra kontekst-genvejsmenuen.

*  “Enable Context" (“Aktiver Indhold"-)
menuen er som standard afmaerket (Til)
pa skrivebordet. Menuen Enable Context
(Aktiver Indhold) ger, at systembakkens ikon
for SmartControl Premium vises. Et hgjreklik
pa jobbakke-ikonen viser menufunktionerne
for“Help” (“Hjeelp”") og ‘Technical Support”
("“Teknisk Stette™). Afmeerk for “Upgrade”
("Opgradering”),"“About” (“Om”) og "“Exit”
(“Afslut”). Nar “Enable Task Tray" (“*Aktiver
Jobbakke™) menuen er deaktiveret, viser
jobbakke-ikonen kun EXIT (AFSLUT).



e “Run at Startup” (“Ker ved Startop”) er
som standard afmarket (Til). Nar den er
deaktiveret, starter SmartControl Premium
ikke ved starten og ikonet vises ikke i
systembakken. SmartControl Premium kan
kun startes fra genvejen pa skrivebordet eller
fra programfilen. Intet forvalg, indstillet til at
kere ved startop, indleeses, nar denne boks
ikke er afmaerket (er deaktiveret).

*  Aktivér gennemsigtighedstilstand (Windows 7,
Vista, XP). Standard er 0% uigennemsigtighed.

“Options > Input” (“Funktioner > Indgang”) —

er kun aktiv, ndr “Input” (“Indgang”) er valgt i
“Options” (“Funktioner”-)rullemenuen. Pa en ikke-
understgttet skeerm med DDC/Ci er kun “Help”
(“Hjeelp™) og “Options” (*‘Funktioner”) til radighed.
Alle andre faneblade i SmartControl Premium er
ikke til radighed.

(=] smartControl Premium &

SmartControl Premium PHILIPS

Input

Your dsplay has two mnputs (connections on back of
this dispiay) so you can hook up two different sources
at the same time. Use the Analog In and Dig
buttons to select which source you'd e to view. You
are currenty viewing the analog in mage.

1]

Adijust Preferences

Audio

before SmartControl functionaity can be restored.

Auto Pot
Tnput

Wizard

Color
£co
eyt g
2
presets
Options Theft Deterrence

w

Muti Montors

Help Analog In Digtal In

*  Vis"Source” (“Kilde") instruktionsruden og
nuveerende indgangskilde indstilling.

*  Ved enkeltindgangsskeerme ses denne rude
ikke.
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“Options > Audio” (“Funktioner > Lyd”) — er
kun aktiv, nar “Volume" (“Lydstyrke”) er valgt i
“Options” (“Funktioner’-)rullemenuen.

Pa en ikke-understattet skeerm med DDC/Ci er
kun “Help” ("Hjeelp"") og “Options” (*“Funktioner”)

til radighed.
] smartControl Premium

SmartControl Premium

]

Adiust Preferences

z

ido.

Auto Prot.

§

Tnput

| 4

Wizard

Presets

Theft Deterrence

Muki Monitors

Ty

PHILIPS

Audio

Adjust the Volume of the integrated loudspeakers by
using the sider.

Tum off the integrated loudspeakers by checking the
Mute checkbox

Option > Audio Pivot (Funktion > Lyd Pivot)

(€] snariCono remiom

SmartControl Premium

i

Adijust

Preferences
\‘ Ao
Color Auto Pivot
\g ot
Eco Wizard
oy 2
e

Options

Muki Monitors

"

‘Theft Deterrence

™ Mute
vame w
= O
unde
I3
PHILIPS

Auto Pivot
To manualy rotate the screen image, cick a rotation
button

Uncheck the Auto Piot box to disable automatic
screen-mage fotation.

™ Enable Auto Pivot



“Help > User Manual” (“Hjzlp >
Brugervejledning”) — er kun aktiv, nar “User
Manual” ("Brugervejledning”) er valgt i “Help”
("Hjeelp"-)rullemenuen. Pa en ikke-understattet
skeerm med DDC/Ci er kun “Help” (“Hjeelp”) og
“Options” (“Funktioner™) til radighed.

Context Sensitive (Indholdssensitiv) menu
“Context Sensitive” (““Indholdssensitiv”’) menuen
er som standard aktiveret. Hvis “Enable Context”
(“Aktiver Indholdssensitiv’') menuen er afmaerket
i “Options > Preferences” (“Funktioner >
Indstillinger”) ruden, ses menuen.

(&] SrartContrl remivm I
— @ SmartControl
SmartControl "emum PHILIPS Select Preset ’
User Manual Tune Display | ot
e e Supere o You e e Otfice
L e L L~
it e i
Gane
= B Biomomy
Color e
)
—— “;‘“ “Context” (“Indhold") menuen har fire punkter
L . 2
\g ospn *  SmartControl Premium — nar valgt, ses
. . “About” (“Om”) skaermen,
\1(? ¥ «  “Select Preset” (“Velg Forvalgt”) — en
optons hierakisk menu med gemte forvalg, der
\Q straks kan bruges. En afkrydsniong viser
= — det i gjeblikket valgte forvalg.“Factory

“Options > Version” (“Funktioner >Version”) —
er kun aktiv, nar “Version” (“Version™) er valgt

i “Help” (“Hjaelp”-)rullemenuen. Pa en ikke-
understattet skeerm med DDC/Ci er kun “Help”
("Hjaelp”) og "Options” (*‘Funktioner”) til radighed.

(& srarionta Prariom

SmartContro

Adjust

Color

-

Eco

)

Options

8§

| Premium

User Manual

Update
Display D
o

System D

Version

Preset” (“Fabriksforvalg”) kan ogsa hentes i
rullemenuen.

» Tune Display (Indstil Skeerm) — abner
kontrolpanelet for SmartControl Premium.

*  Smartlmage — Kontrollér aktuelle indstillinger
for Office (Kontor), Photo (Foto), Movie (Film),
Game (Spil), Economy (@konomi) og Off (Fra).

2%

PHILIPS

Version

SmartControl
Verson 0.00 EVALUATION dtune-plp-R2009-12-17-
13-04

DDC/CI Communication: Yes - PDI APL
Copyright © 1993-2009 Portratt Displays, Inc.
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“Task Tray” (“Jobbakke”-) menu aktiveret
Menuen i systembakken kan ses ved at hgjreklikke
pa SmartControl Premium-ikonet i systembakken.
Et venstreklik starter programmet.

Help

Technical Support
Check for Update
About

Exk

Jobbakken har fem punkter:

*  "Help” ("Hjeelp") — adgang til brugervejledning-
fil: Abner Brugervejledningen med standard
browservinduet.

“Technical Support” (*Teknisk Hjeelp”) — viser
siden med teknisk hjeelp.

"“Check for Update " ("Tjek for

opdateringer”) — leder brugeren til PDI
Landing og tjekker brugerens version i forhold
til den allernyeste version.

"About” ("*Om") — viser detaljerede
referenceoplysninger: Produktversion,
frigivelses-information og produktnavn.

Exit (Afslut) — Luk SmartControl Premium
Hvis du vil kere To run SmartControl Premium
igen, skal du enten vaelge SmartControl
Premium i programmenuen, dobbeltklikke pa
skrivebordet eller genstarte systemet.

PHILIPS

SmartControl Premium

SmartControl
Version 2.02
diune-plp-R2010-05-17-1143-21
Copyright © 1893-2010 Portrait Displays, Tnc.
Patents Pending
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“Task Tray” (“Jobbakke”-)menu deaktiveret

Nar “Task Tray” (“Jobbakke) er deaktiveret

i indstillinger-mappen, er kun valg af “"EXIT”
("AFSLUT") til radighed. Hvis du helt vil fierne
SmartControl Premium fra systembakken, skal du
deaktivere “Run at Startup” ("“Ker ved Startop”)

i “Options > Preferences” (*Muligheder >
Indstillinger”).



3.6 Guide til SmartDesktop

El SmartDesktop

SmartDesktop er en del af SmartControl
Premium. Installér SmartControl Premium og velg
SmartDesktop fra Options (Indstillinger).

[ smartControl Premium 20

SmartControl Premium PHILIPS

SmartDesktop

Select desktop partitioning mode.

5

I¥' Aign to partiion
Adiust
Verticl Horzontal
Auto Piot
. == oo
— Input Even Trpl Vertial
g e 5] =
o Right Vertical Left Vertical
=
— Presets
Theft Deterrence Bottom Horzontal Top Horzontal
Options
SmartDeskion
XQ 2z
Help Identiy

»  Afkrydsningsfeltet Align to partition (Tilpas
til afsnit) vil aktivere automatisk tilpasning af
vinduet ndr det traekkes til det definerede
afsnit.

*  Valg det anskede afsnit ved at klikke pa ikonet.

Afsnittet anvendes pa skrivebordet og ikonet
fremhazeves.

* ldentify (Identificer) giver mulighed for hurtigt
at vises gitret.

Bl Trek og slip vinduer

Nar afsnittene er konfigurerede og du har
valgt Align to partition (Tilpas til afsnit), kan du
treekke et vindue ind i regionen og det tilpasses
automatisk. Nar vinduet og musemarkgren er
inden i regionen, fremhaeves regionen.

© Bemark

Hvis regionens yderkant ikke er synlig nar du
treekker vinduet, er indstillingen “Vis indhold i
vindue, mens der traekkes” deaktiveret. Sadan
aktiveres indstillingen:

1. Klik pa System i Kontrolpanel.

2. Klik pa Avancerede systemindstillinger (i Vista

og Win7 findes denne indstilling i venstre

sidelinje)

| afsnittet Ydelse, klik pa Indstillinger.

4. Marker afkrydsningsfeltet Vis indhold i vindue,
mens der traekkes, og klik pa OK.

w

Anden alternativ sti:

Vista:

Kontrolpanel > Personlige indstillinger >
Vinduesfarve og -udseende > klik pa "Abn klassisk
visning for at fa flere farveindstillinger" > klik pa
knappen "Effekter” > marker Vis indhold i vindue,
mens der treekkes

XP:
Egenskaber for skeerm > Udseende > Effekter.. >
MarkerVis indhold i vindue, mens der traeekkes

Win 7
Ingen anden alternativ sit tilgeengelig.



El Valgmuligheder i titellinje

Desktop Partition kan abnes fra titellinjen i et
aktivt vindue. Det giver en hurtig og nem made at
styre skrivebordet pa, savel som en metode til at
sende et vindue til et afsnit pa, uden traek og slip.
Flyt markeren over pa det aktive vindues titellinje
for at fa adgang til rullemenuen.

B Hgjreklik-menu

Hajreklik pa ikonet for Desktop Partition for at
vise rullemenuen.

Find Windows »
Desktop Partition  »
Identify Partition

Align Off

Exit
: B Snaait (=] [ Window

1. Find Windows (Find vinduer) — | visse tilfeelde
har du muligvis sent flere vinduer til det
samme afsnit. Find Window (Find vinduer)
viser alle dbne vinduer og flytter det valgte

vindue @verst.
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2. Desktop Partition — Desktop Partition viser
det valgte afsnit og giver dig mulighed for at skifte
til et andet afsnit, vist i rullemenuen.

| d9-0 )¢ Philps SmantDesktop Guide (Compatibitty Mode] - Mictosoft Wor

ot v e

SmartDesktop Guide

SmartDesktop - SmartDesktop is in SmanControl Premium. Install SmantControl Premium and select
‘SmantDesktop from Options.

Wsrcont o

PHILIPS

SmartControl Premium

© Bemark

Huvis der er tilsluttet mere end én skaerm, kan
du vaelge malskaermen for at skifte afsnittet.
Det fremhaevede ikon representerer det aktive
afsnit.

3. Identify Partition (Identificer afsnit) —
Viser gitret for det aktuelle afsnit.

4. Align On/Align Off (Tilpas til/fra) — Aktiverer/
deaktiverer den automatiske tilpasningsfunktion
ved trek og slip.

5. Exit (Afslut) — Lukker Desktop Partition og

Display Tune. Du kan genstarte Display Tune
fra startmenuen eller genvejen pa skrivebordet.



B Venstreklik-menu A Hojreklik i systembakke

Venstreklik pa ikonet for Desktop Partition for Systembakkens ikon indeholder ogsa de fleste
hurtigt at sende det aktive vindue til et afsnit uden  funktioner, understgttet af titellinjen (med
treek og slip. Nar du slipper med musen, sendes undtagelse af at sende et vindue til et afsnit).

vinduet til det fremhavede afsnit.

Bl

Bright Light
Dim Light

Help
Technical Support
Check for Update
About
Exit

=

*  Find Windows (Find vinduer) — | visse tilfelde
har du muligvis sent flere vinduer til det
samme afsnit. Find Window (Find vinduer)
viser alle abne vinduer og flytter det valgte
vindue gverst.

*  Desktop Partition — Desktop Partition viser
det valgte afsnit og giver dig mulighed for at
skifte til et andet afsnit, vist i rullemenuen.

* ldentify Partition (Identificer afsnit) —Viser
gitret for det aktuelle afsnit.

* Align On/Align Off (Tilpas til/fra) — Aktiverer/
deaktiverer den automatiske tilpasningsfunktion
ved treek og slip.
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Definitioner for SmartDesktop afsnit

Navn
Full Desktop (Hele
skrivebordet)

Beskrivelse
Anvender alle indstillinger pa hele skrivebordet.

Billede

Vertical (Lodret)

Vurderer skaermopl@sningen og opdeler skaermen i to lige
store, lodrette regioner.

For 90/270 bevares lodret konfiguration.

B

Horizontal (Horisontal)

Vurderer skaermopl@sningen og opdeler skaermen i to lige
store, vandrette regioner.

For 90/270 bevares vandret konfiguration.

Vertical Triple (Lodret
tredobbelt)

Vurderer skeermoplasningen og opdeler skaermen i tre lige
store, lodrette regioner.

For 90 afsnit, 1 vandret topafsnit, 2 vandrette midterafsnit,
3 vandrette bundafsnit.

For 270 afsnit, 3 vandrette topafsnit, 2 vandrette
midterafsnit, 1 vandret bundafsnit.

Vertical Split Left
(Lodret opdeling,
venstre)

Vurderer skeermoplasningen og opdeler skeermen i to
lodrette regioner, venstre side er en enkelt region, hajre
side er opdelt i to lige store regioner.

For 90 afsnit, 1 pa topafsnittet og 2 og 3 nederst.For 270
afsnit, 1 pa bundafsnittet og 2 og 3 averst.

Vertical Split Right
(Lodret opdeling, hgjre)

Vurderer skaermoplasningen og opdeler skarmen i to
lodrette regioner, hgjre side er en enkelt region, venstre
side er opdelt i to lige store regionen

For 90 afsnit, 1 og 2 pa topafsnittet og 3 nederst.
For 270 afsnit, 3 pa topafsnittet og 1 og 2 nederst.
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Navn
Vandret opdeling, top

Beskrivelse

Vurderer skaermopl@sningen og opdeler skaermen
vandret i to lige store regioner. Topregionen er enkelt, og
bundregionen er opdelt i to lige store regioner

For 90 partition 1 i hejre side, lodret partition 2 og 3 i
venstre side, lodret.

For 270 partition 1 i venstre side, lodret partition 2 og 3 i
hgjre side, lodret.

Billede

Vandret opdeling, bund

Vurderer skaeermoplasningen og opdeler skeermen vandret
i to lige store regioner. Bundregionen er enkelt, og
topregionen er opdelt i to lige store regioner

For 90 partition 1 og 2 i hgjre side, lodret partition 3 i
venstre side, lodret.

For 270 partition 1 og 2 i venstre side, lodret partition 3 i
hgjre side, lodret.

Lige opdeling

Vurderer skaermoplasningen og opdeler skeermen i fire lige
store regioner.
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3.7 PowerSensor™"

El Hvordan virker det?

* "PowerSensor” arbejder ud fra princippet
om overfarsel og modtagelse af udskadelige,
"infrargde” signaler til "opdagelse” af
brugertilstedeveerelse.

* Nar brugeren befinder sig foran skaermen,
fungerer denne normalt med de indstillinger,
som brugeren har foretaget med hensyn til
lysstyrke, kontrast, farve osv.

* Huvis det feks. antages, at skeermen var indstillet
pa 100% lysstyrke, da brugeren forlod sin plads
og ikke leengere befinder sig foran skaermen,
reducerer denne automatisk stremforbruget
med op til 80%.

Bruger ikke til stede

(((((mw‘!

Ovenstdende stremforbrug er kun vist som reference

Bruger til stede foran

((((( g

\w‘n‘

L)

E1 Indstillinger

Standardindstillinger

Som standard (Indstilling 3) er"“PowerSensor”
indstillet til at opdage tilstedevaerelsen af en bruger
30-100 cm fra skeermen og op til fem grader til
hgjre og venstre for denne.

Tilpassede indstillinger

Hvis du foretreekker at veere i en position

udenfor de ovenfor anfarte perimetre, skal

du valge en kraftigere signalstyrke for at opna

optimal opdagelse: jo hgjere indstilling, jo

kraftigere opdagelsessignal. For at opna maksimal

"PowerSensor” effektivitet og opdagelse, skal du

anbringe dig selv direkte foran skeermen.

* Hvis du veelger at anbringe dig selv mere
end 100 cm fra skeermen, skal du bruge det
maksimale opdagelsessignal til afstande op til
120 cm (indstilling 4)
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* Da noget merkt tgj har tendens til at
absorbere infrarede signaler; selv nar brugeren
befinder sig indenfor 100 cm fra skaermen, skal
du @ge signalstyrken, ndr du er ifert merkt tg.

*  Der kan til enhver tid vendes tilbage til
standardindstillingen (Indstilling 3)

Sensorafstand

Tastaturgenvej

Landskab/portreet funktion

e g,:
((((((u( )))
o

4

Justering af indstillingerne

Huvis “PowerSensor' ikke fungerer korrekt inden-

eller udenfor standardomradet, kan du finindstille

opdagelsen som falger:

*  Tryk pa “PowerSensor” tastaturgenvejen

* Standardindstillingen ‘3" ses pa indstillingslinjen.

*  Indstil “PowerSensor’ opdagelse til Indstilling 4
og tryk pa OK.

* Test den nye opsatning for at se, om
“PowerSensor” opdager dig i din nuveerende
position.

*  PowerSensor virker kun nar skeermen er
i vandret position. Hvis PowerSensor er
taendt, og skeermen sattes i lodret position
(90 grader), slukker skaermen automatisk.

Og skaermen tender automatisk igen, nar
skeermen sattes til vandret position.

-:

© Bemarkning

En manuelt valgt “PowerSensor” indstilling forbliver
aktiv, indtil den @ndres eller standardindstillingen
aktiveres. Hvis du af en eller anden grund finder; at
"PowerSensor" er for fglsom overfor bevagelse,
skal du indstille pa en lavere signalstyrke.



4. Tekniske specifikationer

Skeermpanel-type TFI-LCD
Baggrundslys LED
Panelstgrrelse 24" W (61,0 cm)
Aspektforhold 16:9

Pixel pitch 0,277 x 0,277 mm
Lysstyrke 250 cd/m?
Smart-kontrast 20.000.000:1
Kontrastforhold (typisk) 1000:1
Reaktionstid (typisk) 5 ms

Optimal oplgsning

1920 x 1080 ved 60 Hz

Signalinput (241B4LP)

Synsvinkel 170° (H) / 160° (V) ved C/R > 10
Billedforbedring Smartlmage

Skaermfarver 16,7 M

Vertikal opdateringshastighed 56 Hz - 76 Hz

Horisontal frekvens 30 kHz - 83 kHz

sRGB JA

DVI-D (Digital), VGA (analog)

Signalinput (241B4LPY)

DVI-D (Digital), VGA (analog), Display port

USB

USB20x2

Inputsignal Separat synk., synk. pa gren

Lyd ind/ud Pc-lyd ind, hovedtelefon ud

Indbyggede hgijttalere 1,5W x 2

Brugerfunktioner &P/« (/¥ SENSOR/A /0K 0]

OSD sprog Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk

og portugisisk

Andre funktioner

VESA montering (100 x 100mm), kensington-lds

"Plug & Play" kompatibilitet

DDC/CI, sRGB, Windows 7/Vista/XE Mac OSX, Linux

Vip -5/+20
Drej -65/+65
Hgjdejustering 100mm




Teendt-tilstand

21,5W (typisk), 38W (maks.) (med lyd og USB x 2)

Teendt-tilstand (DKO-tilstand) 12W

(typisk)

Energiforbrug AC AC AC

(EnergyStar 5.0 testmetode) indgangsspaending indgangsspeending indgangsspaending
ved ved ved
T00VAC +/- 5VAC, | 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz

Normal funktion (typisk) 20,81W 20,75W 20,82W

Sovetilstand (typisk) 0,1W 0,1W 0,1W

Fra oW oW oW

Varmetab* AC AC AC
indgangsspaending indgangsspeending indgangsspaending
ved ved ved
T00VAC +/- 5VAC, [ 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz

Normal drift 71,02BTU 70,82BTU 71,06BTU

Sovetilstand(typisk) 0,34BTU 0,34BTU 0,34BTU

Fra O0BTU OBTU O0BTU

Tendt-tilstand

26W (typisk), 39W (maks.) (med lyd og USB x 2)

Teendt-tilstand (@KO-tilstand) | 12W

(typisk)

Energiforbrug AC AC AC

(EnergyStar 5.0 testmetode) indgangsspaending indgangsspaending indgangsspeending
ved ved ved
100VAC +/- 5VAC, | 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz

Normal funktion (typisk) 21,57W 21,44W 21,42W

Sovetilstand (typisk) 01W 0,1W 01W

Fra ow oW ow

Varmetab® AC AC AC
indgangsspaending indgangsspaending indgangsspeending
ved ved ved
100VAC +/- 5VAC, [ 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
50Hz +/- 3Hz 60Hz +/- 3Hz 50Hz +/- 3Hz

Normal drift 73,62BTU 73,17BTU 73,11BTU

Sovetilstand(typisk) 0,34BTU 0,34BTU 0,34BTU

Fra O0BTU OBTU 0BTU
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Stremdiode

Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Produkt med fod (BxHxD)

Indbygget, 100-240VAC, 50/60Hz

565 x 403 x 227mm

Produkt uden fod (BxHxD)

565 x 352 x 55mm

Kassemal (BxHxD)

624 x 405 x 172mm

Produkt med fod 6,3kg
Produkt uden fod 4,3kg
Produkt med emballage 8,3kg

Temperaturomrade Oplagring: -20°C til 60°C
drift: 0°C til 40°C
Relativ fugtighed 20% til 80%
Hejde Ikke drift: + 40.000 ft (12.192 m)
Betjening: + 12.000 ft (3.658 m)
MTBF 30.000 timer
Lot |
ROHS JA
EPEAT Guld (www.epeat.net)
EnergyStar 50
Emballage 100% genbrugelig

Specifikke stoffer

Myndighedernes godkendelser

Farve

PVC BFR-fri hus

BSMI, CE Mark, FCC Class B, GOST, SEMKO, TCO Certified,
UL/cUL, 1ISO9241-307, TUV-GS, TUV-Ergo

Sort/Salv

Finish

Struktur

=] Bemarkning

1. EPEAT Gold eller Silver er kun gyldig hvor produktet registreres af Philips. Ga til www.epeat.net for

registeringsstatus i dit land.

2. Disse data kan andres uden meddelelse derom. Ga til www.philips.com/support for at hente den

seneste version af brochuren.
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4.1 Oplasning og forvalgte indstillinger

El Maksimal oplgsning

Til 241B4LP/241B4LPY
1920 x 1080 ved 60 Hz (analogt input)
1920 x 1080 ved 60 Hz (digital indgang)

E1 Anbefalet oplasning

Til 241B4LP/241B4LPY
1920 x 1080 ved 60 Hz (digital indgang)

[V frekv (cHz)[ Oplosning [ L frekv (Hz) |
3147 640x480 59,94
37,88 800x600 60,32
48,36 1024x768 60,00
54,00 1152x864 60,00
44,77 1280x720 59,86
47,78 1280x768 59,87
49,70 1280x800 59,81
60,00 1280x960 60,00
63,89 1280x1024 60,02
47,71 1360x768 60,02
5547 1440x900 59,90
55,94 1440x900 59,89
75,00 1600x1200 60,00
64,67 1680x1050 59,88
65,29 1680x1050 59,95
66,59 1920x1080 59,93
74,04 1920x1200 59,95
67,50 1920x1080 60,00

(=) Bemarkning

Bemaerk, at skaermen fungerer bedst med den
indbyggede oplasning pa 1920 x 1080 ved 60 Hz.
Folg den anbefalede oplasning for at opna den
bedste billedkvalitet.
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5. Stromstyring

5.1 Automatisk energispare

Huvis der er installeret et VESA DPM overholdende
skeermkort eller software pa pc'en, kan skermen
automatisk nedsatte stremforbruget, nar den
ikke bruges. Ndr input fra tastatur, mus eller
anden input-enhed registreres, "vagner" skaermen
automatisk igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug og

signalering:

VESA tilstand| Video |V synk| Lsynk | Forbrugt strem | Diodefarve

Aktiv TIL Ja Ja 21,5W (typisk), Hvid
38W (maks.)
(med lyd og
USB x 2)
Sovetilstand FRA Nej Nej 01W Hvid
(typisk) (blinker)
Kontakt Fra FRA - - ow FRA

VESA tilstand| Video |V synk| Lsynk | Forbrugt strem | Diodefarve

Aktiv TIL Ja Ja 26W (typisk), Hvid
39W (maks.)
(med lyd og
USB x 2)
Sovetilstand FRA Nej Nej 01W Hvid
(typisk) (blinker)
Kontakt Fra FRA - - oW FRA

Den fglgende opsetning bruges til at male
skaermens stremforbrug.

Indbyggede oplgsning: 1920 x 1080

Kontrast: 50%

Lysstyrke: 250 nits

Farvetemperatur: 6500k med fuldt, hvidt menster
Lyd og USB inaktiv (fra)

=] Bemarkning
Disse data kan andres uden meddelelse derom.
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6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes environmentally sound
recovery and disposal of waste from
electrical and electronic equipment.
Toxic substances like Lead has been
eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe
to use throughout its life cycle.

Congratulations,
Your display is designed for both you and the

planet!
=
CERTIFIED ensures that your display is
designed, manufactured and tested
according to some of the strictest quality and
environmental requirements in the world. This
makes for a high performance product, designed
with the user in focus that also minimizes the
impact on the climate and our natural
environment.

The display you have just purchased
carries the TCO Certified label. This

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO Certified
represents one of the toughest certifications for
displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

Visual ergonomics for good image quality is
tested to ensure top performance and reduce
sight and strain problems. Important parameters
are luminance, contrast, resolution, black level,
gamma curve, colour and luminance uniformity
and colour rendering

Products are tested according to rigorous safety

standards at impartial laboratories

* Electric and magnetic fields emissions as low as
normal household background levels

* Low acoustic noise emissions (when applicable)

Some of the Environmental features of the TCO
Certified for displays:

The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS or
ISO 14001)

Very low energy consumption both in on- and
standby mode minimize climate impact
Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and heavy
metals such as cadmium, mercury and lead
(RoHS compliance)

Both product and product packaging is prepared
for recycling

The brand owner offers take-back options

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as well
as manufacturers all over the world. Since the end
of the 1980s TCO has been involved in influencing
the development of IT equipment in a more user-
friendly direction. Our labeling system started with
displays in 1992 and is now requested by users
and [Tmanufacturers all over the world. About
50% of all displays worldwide are TCO certified.

For more information, please visit
www.tcodevelopment.com

For displays with glossy bezels the user should
consider the placement of the display as the bezel
may cause disturbing reflections from surrounding
light and bright surfaces.
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EPEAT
(www.epeat.net)

#», 'The EPEAT (Electronic Product
Q:b .
Environmental Assessment Tool)
. program evaluates computer
desktops, laptops, and monitors based on 51
environmental criteria developed through an
extensive stakeholder consensus process
supported by US EPA.
EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,

and provides an opportunity for manufacturers to

secure market recognition for efforts to reduce
the environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following

standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment)

«  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)

*  EN55024:1998+A1:2001+A2:2003 (Immunity

requirement of Information Technology
Equipment)

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission)

*  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable

*  2006/95/EC (Low Voltage Directive)

*  2004/108/EC (EMC Directive)

»  2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on I1SO9000
level.

The product also comply with the following
standards

* 15O9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

*  GS EK1-2000:2009 (GS mark requirement)

»  prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

*  MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO certified (Requirement for Environment
Labeling of Ergonomics, Energy, Ecology and
Emission, TCO: Swedish Confederation of
Professional Employees) for TCO versions

Energy Star Declaration
(www.energystar.gov)

h As an ENERGY STAR® Partner, we

have determined that this product

meets the ENERGY STAR® guidelines
for energy efficiency.

& Note

We recommend you switch off the monitor when
it is not in use for a long time.



Federal Communications Commission (FCC)
Notice (U.S. Only)

€& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

*  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

e

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.
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Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de facon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

&tre décelé en fermant I'équipement, puis en
le remettant en fonction, I'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

* Augmenter la distance entre I'équipement et
le récepteur.

* Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as describad in EN 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following appliss to
davicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of the
davics is obliged to take all stape necessary to remove sources of infarfersnce o tela-
communication or other devicss.

Pulmdnan[nutypmémﬁﬂm poditade uvadeno, Ze spadé do do ffidy A podle EN 55022,

spada automaticky do tfidy B podie EN 55022, Pro zafizeni zafazend do tidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-Ii k rudan( telekomunikatnich nebo
Pnych zafizeni je ufvatel povinmen provést takowvd opatfgnl, aby reSeni odstranil.




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILFORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

HAZHARESIE |
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Réntgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal

durchgefuhrt werden.
2. nur original-Ersatzteile verwendet werden.
3. bei Ersatz der Bildréhre nur eine bauartgleiche

eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhohte Augenbelastung bei zu geringem
Zeichenkontrast wéren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

(A

ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter pa
fladskaerme

Philips tilstreeber at levere produkter af den hgjeste
kvalitet.Vi anvender nogle af branchens mest
avancerede produktionsprocesser og udferer en
streng kvalitetskontrol. En gang imellem er defekte
pixler eller sub-pixler pa TFT skaermpaneler dog
uundgaelige. Ingen producent kan garantere,

at alle paneler vil vaere fri for pixeldefekter,

men Philips garanterer, at enhver skeerm med

et uacceptabelt antal defekter repareres eller
udskiftes under garantien. Dette notat forklarer de
forskellige former for pixeldefekter og definerer
de acceptable defektniveauer for hver type. For
at veere berettiget til reparation eller udskiftning
under garantien skal antallet af pixeldefekter pa

et TFT skaermpanel overskride disse acceptable
niveauer: For eksempel ma hgjst 0,0004% af sub-
pixlerne pa en skeerm veere defekte. Desuden
seetter Philips endnu hgjere kvalitetsnormer for
visse typer eller kombinationer af pixeldefekter;
derer mere generende end andre. Denne
pixelpolitik geelder i hele verden.

subpixel subpixel subpixel

v
il B

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af tre
sub-pixler med primerfarverne red, gren og bla.
Nar mange pixler settes sammen, kan de danne et
billede. Nar alle sub-pixler i en pixel lyser, fremstar
de farvede sub-pixler tilsammen som enkelt hvid
pixel. Hvis de alle er mgrke, fremstar de tre farvede
sub-pixler tilsammen som en enkelt sort pixel.
Andre kombinationer af oplyste og marke sub-
pixler fremstdr som enkelte pixler i andre farver.

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa skeermen
pa forskellige mader. Der er to kategorier af
pixeldefekter og flere typer sub-pixeldefekter i
hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels eller
underpixels, der altid lyser eller er "pa". Det vil
sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, nar skaermen viser et markt
meanster. Der er felgende typer defekte lyse
prikker:

En teend red, gren eller bld sub-pixel

I @

To sammenliggende tendte sub-pixler:
Rad + Bla = Lilla

Red + Gregn = Gul

Grgn + Bla = Cyan (Lysebla)

Tre sammenliggende teendte pixler (en hvid pixel)
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€& Bemarkning

En red eller bld lys prik skal vaere mere end 50
procent lysere end de omkringliggende prikker,
mens en gron lys prik er 30 procent lysere end de
omkringliggende prikker.

Defekte mgrke prikker

Defekte marke prikker fremkommer som pixels
eller underpixels, der altid er mgrke eller "fra". Det
vil sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, nar skaermen viser et merkt
meanster. Der er felgende typer defekte mearke

prikker:

Textliggende pixeldefekter

Da pixel- og sub-pixeldefekter af samme type,
der ligger teet pa hinanden, kan vaere mere
igjnefaldende, specificerer Philips ogsa tolerancer
for teetliggende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal et TFT skeermpanel i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,

der overskrider de tolerancer, der er gengivet i
folgende tabeller

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU

1 teendt sub-pixel 3
2 sammenliggende taendte sub-pixler 1
3 sammenliggende taendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU

1 merk sub-pixel 5 eller feerre
2 sammenliggende mgarke sub-pixler 2 eller ferre
3 sammenliggende mgrke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre

SAMLEDE DOT-DEFEKTER

Samlede bright- eller black dot-defekter af alle typer

ACCEPTABELT NIVEAU
5 eller faerre

e Bemarkning

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1509241-307 (1ISO9241-307: Testmetoder for ergonomisk
krav, analyse og overensstemmelse for elektroniske skeerme til fremvisning)



7.2 Kundeservice og garanti

Kundeservice og garanti

For oplysninger om garantideekning og geeldende stettekrav i dit omrdde, bedes du besgge www.philips.
com/support. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tIf Pris

Austria Siemens 1&S +43 0810 000206 €007
Belgium E Care +32 078 250851 €0.06
Denmark A-novo +45 3525 8761 Local call tariff
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0.09
Germany Siemens 1&S +49 01803 386 853 €0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Italy A-novo +39 840 320 041 €0.08
Luxembourg E Care +352 26 84 30 00 Local call tariff
Netherlands E Care +31 0900 0400 063 €0.10
Norway A-novo +47 2270 8250 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0.10
Sweden A-novo +46 08 632 0016 Local call tariff
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:

Land Callcenter ASC Kundeservice tIf
Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Czech Rep. NA Asupport 800 100 697
Estonia NA FUJITSU +372 6519900
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080
Latvia NA “ServiceNet LV" Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
E—_— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Ejg:i;fegm NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC H.and +386 1 530 08 24
et NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Turkey NA Techpro +90 212 444 4 832

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter Kundeservice tif
Argentina Vermont 0800 3330 856
Brazil Vermont 0800-7254101

Kontaktoplysninger til NORDAMERIKA:

Land Callcenter ASC Kundeservice tIf
Canada Supercom Supercom (800) 479-6696
USA TOS Teleplan (877) 835-1838

Kontaktoplysninger til Kina:

Kina

Kundeservice tlf: 4008 800 008




Kontaktoplysninger til APMEA:

Land Callcenter ASC Kundeservice tIf
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
Bancladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992
buy-out)
Hong Kong / . Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pxels Technology Ltd. | 1. i Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
. . . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
Israel NA Eastronics LTD 1-800-567000
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
New Zealand | NA Visual Group Ltd. 0800 657447
Pakistan NA Philips Consumer Service (9221) 273741116
T . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
South Korea NA PCS One Korea Ltd. 080-600-6600
Sri Lanka NA no d}strlbutor and/or service
provider currently
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
Jnited Arab {5 AL SHAHD COMPUTER LLC {00971 4 2276525
Emirates
FPT Service Informatic +84 8 38248007 Ho Chi Minh City
Vietnam NA C Ltd +84 5113.562666 Danang City
Sy +84 5113.562666 Can tho Province
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan klares
af brugeren selv. Hvis problemet stadig er der, efter
at du har prevet disse lgsninger, skal du kontakte
Philips's Kundeservice.

El Almindelige problemer

Intet billede (stremdiode lyser ikke)

* Kontroller, at el-ledningen er anbragt i
stikkontakten og bag pd skeermen.

* Kontroller ferst, at stremkontakten foran pa
skeermen er i OFF (FRA) position og tryk den
derefter i ON (TIL) position.

Intet billede (stremdiode blinker hvidt)

* Kontroller, at der er teendt for computeren.

* Kontroller; at signalkablet er korrekt forbundet
til computeren.

* kontroller, at der ikke er nogen bgjede stikben
i signalkablets tilslutningsende. Hvis der er det,
skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan vare aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller, at signalkablet er korrekt forbundet
til computeren. (Se ogsa Hurtig start-
vejledningen).

* Tjek, om skeermkablets stikben er bgjede.

»  Kontroller, at der er teendt for computeren.
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AUTO (AUTOM.)-knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.

© Bemarkning
Den automatiske funktion er ikke ngdvendig i DVI
digital-tilstand.

Synlige tegn pa rog eller gnister

*  Forsag ikke at fejlfinde

*  Treek straks skaermens stik ud af stikkontakten

* Kontakt straks en repraesentant fra Philips
kundeafdeling.

E1 Billeddannelses-problemer

Billedet er ikke centreret

* Justér billedets position med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock (Fase/
Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.

Billede vibrerer pa skermen
» Tjek, at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i OSD-menuernen. Den kan kun
bruges i VGA-tilstand.



Vandret flimren

“

e Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/Clock
(Fase/Klokke) i USD hovedmenuen. Den kan
kun bruges i VGA-tilstand.

Billedet er slgret, uklart eller for merkt
* Indstil kontrast og lysstyrke i OSD.

Der forbliver et "efterbillede",
"indbraendingsbillede" eller "spagelsesbillede”,
efter at der er slukket for stremmen

*  Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan forarsage,
at det "braendes fast” pa skaermen, dvs. de
sakaldte “spogelsesbilleder’ pa din skaerm.
“Fastbreending” og “‘spagelsesbilleder” er
velkendte faenomener inden for skeermpanel-
teknologien. | de fleste tilfeelde forsvinder
"indbreending" eller "efterbillede” eller
"spogelsesbillede” gradvist, efter at strammen
er slaet fra.

*  Serg altid for at aktivere en pauseskarm, der
bevager sig, nar skaermen efterlades uden at
blive anvendt.

* Serg altid for at aktivere et program, der
opdaterer skaeermbilledet regelmaessig, hvis
skarmen viser indhold, der ikke skifter:

* Imidlertid forsvinder alvorligere tilfeelde af
“fastbreending” og "‘spagelsesbilleder” ikke
og kan ej heller fiernes ved reparation.
Ovennavnte skader er ikke deekket af
garantien.

Billedet er forvraenget. Tekst er utydelig eller

sloret.

* Indstil pc'ens skaeermoplasning som skaermens
anbefalede, native oplasning.

Der ses rgde, bld, merke og hvide pletter pa

skaermen

* De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag. Se
politikken om pixels for yderligere oplysninger.

"Teendt"-lyset er for kraftigt. Det forstyrrer
* Du kan justere “Teendt"-lyset med Stremdiode

i OSD-menuerne.
H Lydproblem

Ingen lyd

*  Kontrollér, om lydkablet er korrekt sluttet til
pc'en og skermen.

* Kontrollér, at lyden ikke er sldet fra. Tryk pa
OSD’ens “Menu”, vaelg “Audio” (Lyd) og
derefter “Mute” (Lyd fra). Marker i position
"Off” (Fra).

e Tryk pa"Volume" (Lydstyrke) i OSD-menuen
for at justere lydstyrken.

B USB-problem

USB-tilsluttet udstyr fungerer ikke

*  Kontrollér, om USB upstream-kablet er
tilsluttet korrekt

*  Sluk for skeermen, og teend den igen. Det kan
vaere ngdvendigt at installere/geninstallere
USB-driverne pa din pc og sikre, at hubben er
aktiv.

*  Gentilslut det USB-tilsluttede udstyr

For yderligere hjalp, se venligst Forbruger-
informationscentre-listen og kontakt Philips’s
Kundeservice.



8.2 FAQ for SmartControl Premium

SP1.

Sv.:

SP2.

Sv.:

Jeg har udskiftet skaermen pa en pc

til en anden skarm, og nu fungerer
SmartControl Premium ikke lengere. Sv.
Hvad skal jeg gore?

Genstart din pc og se, om SmartControl
Premium fungerer nu. Eller skal du
afinstallere og geninstallere SmartControl
Premium for at sikre, at den korrekte driver
er installeret.

SmartControl Premium fungerede fint
tidligere, men nu virker programmet ikke
leengere. Hvad skal jeg gore?

Hvis nogle af de felgende handlinger har
vaeret udfert, skal skeermdriveren maske
geninstalleres.
* Videografikadapter er blevet udskiftet med
en anden
* Opdater videodriver Sy.:
Aktiviteter i OS som f.eks. servicepakke
eller programrettelse
* Opdater Windows og opdater skeerm- og/
eller videodriver
* Windows blev startet med skeermens
strem slaet fra eller afbrudt.
For at finde ud af det, skal du klikke pa
“Denne Computer” og derefter pa
Egenskaber -> Hardware ->Enhedsstyrer.
Hvis du ser “Plug & Play skeerm” under
Skaerm, skal du geninstallere. Afinstallér
SmartControl Premium og geninstallér
det.
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SP3.

SP4.

Efter installation af SmartControl Premium
sker der ingenting, selv om jeg klikker pa
fanen SmartControl Premium og venter,
eller der vises en fejlmeddelelse. Hvorfor?

Det skyldes muligvis, at din grafiske adapter
ikke er kompatibel med SmartControl
Premium. Hvis grafikadapteren er en

af ovennaevnte merker, skal du preve

at downloade den mest opdaterede
grafikadapterdriver fra det pageeldende
firmas ? websted. Installer driveren. Afinstallér
SmartControl Premium og geninstallér det
igen. Hvis det stadig ikke virker, er vi bange
for, at grafikadapteren ikke understgttes.
Ga til Philips websted og kontrollér, om der
findes en nyere driver for SmartControl
Premium.

Nar jeg klikker pa “Product Information”
(“Produktinformation”), ses kun nogle af
oplysningerne. Hvad er der sket?

Det kan vare, at din grafikkortadapterdriver
ikke er den mest opdaterede version, som
fuldt ud understetter DCC/CI greenseflade.
Prgv at downloade den mest opdaterede
grafikkortadapterdriver fra det pagaeldende
firmas ? websted. Installer driveren. Afinstallér
SmartControl Premium og geninstallér det
igen.

Attention

Theft Deterence enabled




SP5. Jeg har glemt min PIN-kode til Theft

Sv.:

SPé.

Sv.:

Deterence (Anti-tyveri) funktionen. Hvad
gor jeg!

Philips servicecenter forbeholder sig retten
til at bede om legitimation og godkendelse
for at kunne etablere skaermens ejer.

Bemaerk, at tyverisikringsfunktionen er en
nyttig funktion, der felger med som gratis
ekstraudstyr. Ansvaret for styring af PIN-
koder ligger alene hos den individuelle
bruger eller organisationen, der opseetter
dem.

Hvis PIN-koden glemmes, kan Philips
servicecenter nulstille den for et mindre
gebyr, efter verificering af ejerskab. Bemaerk,
at denne aktivitet ikke er deekket af standard
garantien.

| en skeerm med Smartlmage-funktion
svarer sRGB-funktionen i farvens
temperaturfunktion i SmartControl
Premium ikke. Hvorfor?

Nar Smart-billede er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge
sRGB skal du deaktivere Smart-billede med
E] foran pé skeermen.
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8.3 Generelle FAQ

SP1:

Sv.:

SP2:

Sv.:

Hvad skal jeg gare, hvis skeermen under
installationen viser “Cannot display this
video mode” (“Kan ikke vise denne
videotilstand’)?

Den anbefalede oplgsning for denne skaerm:

1920 x 1080 ved 60Hz.

Frakobl alle kabler og forbind derefter
pc'en til skeermen, som du brugte fer

* | Windows Start Menu, veelg Indstillinger/
Kontrolpanel. | Kontrolpanel vinduet veelg
Skeerm-ikonen. | Egenskaber for Skaerm
vinduet valg “Indstillinger” fanebladet.
Under indstillinger, skub skyderen til
1920 x 1080 pixler.

+ Abn “Avanceret” og indstil
opdateringshastigheden pa 60Hz og klik
derefter pa OK.

» Genstart computeren og gentag trinene
2 og 3 for at bekreefte, at pc'en er indstillet
pa 1920 x 1080 ved 60Hz.

* Luk for computeren, frakobl den gamle
skaerm og genforbind Philips skeermen.

* Teend for skeermen og derefter for pcen.

Hvad ger den anbefalede
opdateringshastighed for skermen?

Den anbefalede opdateringshastighed for
skaeerme er 60Hz. | tilfelde af forstyrrelser
pa skeermen skal du seette den op til 75Hz
og se, om dette flerner forstyrrelserne.

SP3:

Sv.:

SP4:

Sv.:

SP5:

Sv.:

SPé:

Sv.:
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Hvad er .inf og .icm filerne pa cd-rom’en?
Hvordan installerer jeg driverne (.inf og
.icm)?

Dette er skeermens driverfiler: Installer
driverne i henhold til brugervejledningens
anvisninger. Computeren kan bede dig om
skeermdrivere (.inf og .icm filer) eller om en
driverdisk, nar du installerer skeermen fgrste
gang. Indszet (medfelgende cd-rom) i pakken
i henhold til anvisningerne. Skaermdrivere
(iinf og .icm filer) installeres automatisk.

Hvordan justerer jeg oplasningen?

Skaermkortet/grafikdriveren og skaermen
bestemmer sammen opl@sningerne til
radighed. Du kan veelge den gnskede
opl@sning "“Egenskaber for Skeerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg justerer
skaermen?

Sa skal du blot trykke pa OK og derefter
valge “Reset” (‘Tilbagestil”) for at ga tilbage
til de oprindelige fabriksindstillinger.

Er skeermen modstandsdygtig overfor
ridser?

Det anbefales generelt ikke at udsette
skaermens overflade for kraftige sted. Den
er beskyttet mod skarpe og stumpe ting.
Nar du handterer skeermen sa pas pa ikke
at trykke for kraftigt pa skeermens overflade.
Det kan pavirke garantibetingelserne.



SP7:

Sv.:

SP8:

Sv.:

Hvordan renger jeg skaermens overflade?

Til normal renggring skal du blot anvende
en ren, blad klud.Til kraftigere renggring
skal du bruge isopropylalkohol. Brug ikke
andre oplgsningsmidler sdsom ethylalkohol,
ethanol, acetone, hexan osv.

Kan jeg ®ndre skarmens farveindstilling?

Ja, du kan andre farveindstillingen via OSD

pa felgende made:

* Tryk pa “OK" for at vise OSD (On Screen
Display)-menuen

* Tryk pa “Ned-pil” for at veelge indstillingen
“Color” (Farve), og tryk derefter pa “OK"
for at angive farveindstillingen. Der er tre
indstillinger, som vist nedenfor.

1. ColorTemperature (Farvetemperatur)

- de seks indstillinger er 5000K, 6500K,
7500K, 8200K, 9300K og 11500K. Med
indstillinger i 5000K omradet virker
skaermen "varm’ med en rgd-hvid
farvetone, mens en 11500K temperatur
giver en "“kold” bla-hvid toning.

. SRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks. digitale
kameraer, skeerme printere, skannere
osv.)

. Brugerdefiner - brugeren kan valge sin
foretrukne farveindstilling ved at indstille
den rede, granne og bla farve.

€& Bemark

Et mal for farven pa lys, der udstrales fra et objekt,
mens det opvarmes. Dette mal udtrykkes pa en
absolut skala (kelvingrader). Lavere kelvingrader
sasom 2.004K er rgde, hgjere temperaturer sasom
9.300K er bla. Neutral temperatur, 6.504K, er hvid.
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SP9:
Sv.:

SP10:

Sv.:

SP11:
Sv.:

SP12:

Sv.:

Kan Philips skermen monteres pa vaggen!

Ja. Philips skaerme har denne ekstra egenskab.
Standard VESA monteringshullerne pa
bagsiden tillader montering af Philips
skaeermen pa de fleste VESA standardarme
og -tilbeher.Vi anbefaler, at du kontakter

en repreasentant for Philips salgsafdeling for
yderligere oplysninger.

Kan jeg forbinde min skaerm til enhver pc,
arbejdsstation eller Mac?

Ja. Alle Philips skaerme er fuldt kompatible
med standard pc'er, Mac'er og
arbejdsstationer. En ledningsadapter kan
veere ngdvendig for at kunne forbinde
skaermen til dit Mac-system.Vi anbefaler; at
du kontakter Philips salgsrepreesentant for
yderligere oplysninger.

Er Philips skaerme “Plug & Play”?

Ja, skeermene er “Plug & Play"" kompatible
med Windows 7/Vista/XP/NT, Mac OSX,
Linux.

Hvad er “billedklaebning” eller
“billedindbranding” eller “efterbillede”
eller “spogelsesbillede” pa skerme?

Uafbrudt visning af stille eller statiske
billeder over en lengere periode kan
forarsage, at det “breendes fast” pa skaermen,
dvs. de sékaldte “spagelsesbilleder” pa din
skeerm. “Fastbreending” og “‘spagelsesbilleder’”
er velkendte faenomener inden for
skaeermpanel-teknologien. | de fleste tilfeelde
forsvinder “indbreending’ eller “efterbillede”
eller “spagelsesbillede” gradvist, efter at
stremmen er slaet fra.

Serg altid for at aktivere en pauseskarm,
der beveager sig, nar skaermen efterlades
uden at blive anvendt.

Serg altid for at aktivere et program, der
opdaterer skeermbilledet regelmaessig, hvis
skaermen viser indhold, der ikke skifter.



D) Advarsel

Alvorlig “indbreending”- eller “efterbillede’- eller
“spogelsesbillede”-symptomer forsvinder ikke og
kan ikke repareres. Ovennzvnte skader er ikke
deekket af garantien.

SP13: Hvorfor viser skaermen ikke skarp tekst?
Hvorfor viser den forrevne tegn?

Sv..  Skarmen arbejder bedst med sin native
oplgsning pa 1920 x 1080 ved 60Hz.
Brug denne oplgsning for at opna det
bedste billede.
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